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ΕΡΓΑΣΤΗΡΙΟ 8ο: Ταξινομήσεις εικόνων – Επιβλεπόμενη ταξινόμηση μέρος 2 
 
Στο προηγούμενο εργαστήριο είχαμε ξεκινήσει να ταξινομούμε την ΠΠ Ροδόπης με βάση επιβλεπόμενη 

ταξινόμηση.  

Το επίπεδο ανάλυσης ήταν πολύ συνοπτικό, καθώς ταξινομήσαμε την περιοχή σε τέσσερις κατηγορίες 

1) Δάσος, 2) Μερικώς δασοσκεπής έκταση, 3) Ανοίγματα και δ) Υδάτινες επιφάνειες. 

Τι έχουμε δει μέχρι τώρα: 

1. Για να κάνουμε επιβλεπόμενη ταξινόμηση χρειαζόμαστε περιοχές εκπαίδευσης (Region Of 

Interest - ROI στην  ορολογία του ENVI). 

2. Η σωστή επιλογή των ROIs είναι ουσιαστικής σημασίας για τη σωστή ταξινόμηση. 

3. Διαφορετικοί αλγόριθμοι ταξινόμησης μπορεί να δώσουν διαφοροποιημένα αποτελέσματα, 

άρα μια καλή εικόνα της περιοχής που θέλουμε να ταξινομήσουμε είναι απαραίτητη για την 

αξιολόγηση των αποτελεσμάτων. 

4. Για κάποιες κατηγορίες (π.χ. Υδάτινες επιφάνειες, ανοίγματα) ήταν ευκολότερο να συλλέξουμε 

ROIs, για κάποιες άλλες (π.χ. μερικώς δασοσκεπείς (ΜΔ) εκτάσεις) δυσκολότερο. 

5. Κάποιοι υπερεκτιμήσαμε τις ΜΔ εκτάσεις, κάποιοι υπερεκτιμήσαμε τα δάση. Αυτό συμβαίνει 

καθώς πολλές φορές κάποια ROI έχουν παραπλήσιες φασματικές υπογραφές και όταν 

συμβαίνει μικρή επικάλυψη περιοχών εκπαίδευσης, μπορεί αυτή να προκαλέσει μεγάλες 

αλλαγές στις αποφάσεις του εκάστοτε αλγόριθμου για τον καθορισμό της κατάλληλης 

κατηγορίας. 

 

Διακριτική ικανότητα των ROIs 

Πως μπορούμε να ξέρουμε αν τα συλλεγόμενα δείγματα εκπαίδευσης διαφοροποιούνται αρκετά 

ώστε να μας δώσουν αξιόπιστα αποτελέσματα; 

Η απάντηση σε αυτό βρίσκεται στην αναγνώριση της διακριτικής ικανότητας των δειγμάτων. Κάθε 

λογισμικό έχει τα δικά του εργαλεία για να το κάνει αυτό. Έτσι και στο EVI είναι εφικτή η εξακρίβωση 

της διακριτικής ικανότητας των ROIs πριν την ολοκλήρωση της ταξινόμησης, με στόχο την διόρθωση 

των συλλεγόμενων δειγμάτων. 

Ας το δοκιμάσουμε στα δείγματα που έχουμε ήδη από το προηγούμενο εργαστήριο (Lab7) και μετά θα 

το δοκιμάσουμε και στο σημερινό εργαστήριο. 
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Αν τα έχουμε σώσει (όπως θα έπρεπε) στο μενού του ROI Tool > File > Restore ROIs και επιλέγουμε το 

κατάλληλο αρχείο με κατάληξη ...roi. Σβήστε την πρώτη σειρά (Region # 1 που εισάγεται αυτόματα). 

 

 

 

 

 

Από το μενού Options  επιλέγουμε Compute ROI Separability, όπου 

επιλέγουμε την εικόνα στην οποία θέλουμε να 

αξιολογήσουμε τα δείγματα και μετά όλα τα δείγματα 

μας.  

Εδώ έχουμε μόνο τις έξι ζώνες της Landsat 5, αλλά θα 

μπορούσαμε να έχουμε εικόνα με πολλές φασματικές 

ζώνες (π.χ. ένωση φασματικής πληροφορίας και 

δεικτών βλάστησης). 

Στον πίνακα που θα εμφανιστεί βλέπουμε δύο tests (Jeffries-Matusita και Tranformed Divergence) 

φασματικής διαφοροποίησης ανάμεσα σε μία κατηγορία προς τις υπόλοιπες. Αλλά αυτό που κρατάμε 

είναι ότι η απόλυτη διαφοροποίηση ανάμεσα σε δύο κατηγορίες πρέπει να ισούται με το 2, ενώ 

κατηγορίες με τιμές κάτω από 1.9 θα πρέπει να τις λάβουμε με επιφύλαξη, ενώ σε τιμές πολύ 

παρακάτω, οι κατηγορίες αυτές θα χρειαζόντουσαν ενοποίηση για να παρουσιάσει η ταξινόμηση 

αξιόπιστα αποτελέσματα (ή να παρθούν καλύτερα δείγματα). 

Π.χ. το νερό με όλες τις κατηγορίες 

έχει πολύ καλή απόδοση, ενώ από 

όλες τις άλλες κατηγορίες μεγάλη 

αβεβαιότητα παρουσιάζουν 

(τουλάχιστον εδώ) οι κατηγορίες 

Open και Semi-Forest λόγω και της 

διπλής υπόστασης του Semi-Forest.  

Ένα ενδιαφέρον στον πίνακα είναι το 

κάτω τμήμα του, που μας δείχνει 

από το χειρότερο στο καλύτερο τη 

διαφοροποίηση των δειγμάτων. 
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Ταξινόμηση Ροδόπης σε επίπεδο 2 (... και μετά στο επίπεδο 3) 

Ας πάμε παρακάτω ... και λίγο πιο δύσκολα από το σχετικά απλό δάσος / ανοίγματα / νερό 

Σε πραγματικές εργασίες ταξινόμησης θα χρειαστούμε να διαφοροποιήσουμε τις δασικές εκτάσεις στα 

βασικά δασικά είδη που το αποτελούν. Θα αρχίσουμε με το επίπεδο 2 διαφοροποιώντας αρχικά τα 

δάση σε κωνοφόρα και πλατύφυλλα και μετά θα προχωρήσουμε στο επίπεδο 3.  

Να θυμηθούμε (δις) τα επίπεδα ανάλυσης: 

 Επίπεδο 1: Δάσος, Μερικώς δασοσκεπής έκταση, Ανοίγματα, Υδάτινες επιφάνειες 

 Επίπεδο 2: Δάσος -> Κωνοφόρα, Πλατύφυλλα 

 Επίπεδο 3: Κωνοφόρα -> Ερυθρελάτη και Πεύκη, Πλατύφυλλα -> Οξυά και Δρυς 
 

Πως προχωράμε!!! 

Αν θα δημιουργήσουμε δείγματα (ROIs) από την οθόνη (δηλαδή από την ίδια την εικόνα) θα χρειαστεί 

να δημιουργήσουμε ψευδοέγχρωμες εικόνες που να μπορούμε να αναγνωρίσουμε τα δάση σε 

κωνοφόρα και πλατύφυλλα. 

Ας κάνουμε σήμερα ένα νέο RGB στο 753. 

Δεν είναι ξεκάθαρο τι είναι τι;  

Με σκούρο μπλέ χρώμα τα κωνοφόρα, με πράσινο τα πλατύφυλλα και με άσπρο τα ανοίγματα. (Γιατί 

άσπρο;) 

 

Ας θυμηθούμε λίγο τις φασματικές υπογραφές.  

Φτιάξτε μια φασματική βιβλιοθήκη με βάση τις κατηγορίες 1) ανοίγματα, 2) νερό, 3) κωνοφόρα και 4) 

πλατύφυλλα και σώστε τη.  

Θα τη χρειαστούμε!! 
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 Αν δεν βλέπετε την κόκκινη μπάρα (που είναι στο μέσο υπέρυθρο (Β7), αλλάξτε το εύρος των τιμών 

του Χ από 2.223 σε 2.5 (Edit > Plot parameters > Axis Title) 

                                    

 

Με βάση αυτές τις υπογραφές, σε ποιες 

ζώνες μπορούμε να διακρίνουμε καλύτερα 

τις κατηγορίες που θέλουμε να 

ταξινομήσουμε; 

Τι παρατηρείται στην κατηγορία ΜΔ; 

Κάντε μια επιβλεπόμενη ταξινόμηση με βάση 

τη φασματική βιβλιοθήκη.  

Πως; 

Δώστε στα νερά, ανοίγματα αυστηρό κριτήριο γωνίας 0.1, στα ΜΔ και πλατύφυλλα 0,2 και στα 

κωνοφόρα 0.3 

 

Όχι και άσχημα!!! για ένα μόνο σημείο που επιλέξαμε για 

τη βιβλιοθήκη. 
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Ας κάνουμε επανάληψη του προηγούμενου εργαστηρίου και ας κρατήσουμε τα δείγματα για τα νερά, 

ανοίγματα και ΜΔ που είχαμε δημιουργήσει, αλλά θα σβήσουμε τα δάση και στη θέση τους θα 

πάρουμε δείγματα για κωνοφόρα και πλατύφυλλα. 

 Υπολογίστε τη φασματική διαφοροποίηση τους. 

 

 

Αν τα έχουμε κάνει καλά, θα διακρίνουμε μια καλή διαφοροποίηση ανάμεσα στα κωνοφόρα και 

πλατύφυλλα, που θα μας οδηγήσει προφανώς και σε καλή ταξινόμηση. Ας χρησιμοποιήσουμε το 

Support Vector Machine για την ταξινόμηση των δειγμάτων (αφήνοντας τις τιμές που μας προτείνει). 

Κόψτε την εικόνα στα όρια της Ροδόπης (στο τέλος της ταξινόμησης) και ελέγξτε μερικά σημεία 

κωνοφόρων με το Google Earth (Tools > SPEAR > Google Earth > Jump to Location).  

 

 

WELL DONE. Μέχρι εδώ όλα καλά... Σώστε τα ROIs ως 2ndlevel 
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Ταξινόμηση Ροδόπης στο επίπεδο 3 

Να θυμηθούμε (τρις) τα επίπεδα ανάλυσης: 

 Επίπεδο 1: Δάσος, Μερικώς δασοσκεπής έκταση, Ανοίγματα, Υδάτινες επιφάνειες 

 Επίπεδο 2: Δάσος -> Κωνοφόρα, Πλατύφυλλα 

 Επίπεδο 3: Κωνοφόρα -> Ερυθρελάτη και Πεύκη, Πλατύφυλλα -> Οξυά και Δρυς 
 

Τώρα τα δύσκολα.  

Και το βασικότερο θα χρειαστούμε και πολλά από ότι μάθαμε, θυμόμαστε (;) από τα προηγούμενα.  

Αλλά στην Τηλεπισκόπηση για όλα χρειάζεται μια στρατηγική βημάτων. Αν κάναμε την ταξινόμηση με 

βάση αντικειμενοστραφή λογική, θα μπορούσαμε να κρατήσουμε τα αντικείμενα «νερού», 

«ανοιγμάτων» και «ΜΔ» αυτούσια και να κάναμε τους διαχωρισμούς στα κυρίαρχα είδη τους, είτε στο 

αντικείμενο «Κωνοφόρων,» είτε στο αντικείμενο «Πλατύφυλλων». ΑΛΛΑ ΜΕ ΑΥΤΑ ΘΑ ΑΣΧΟΛΗΘΟΥΜΕ 

από το επόμενο εργαστήριο.  

Με βάση την Pixel based ταξινόμηση που κάνει κυρίως το ENVI, κάθε νέα στρατηγική εφαρμόζεται σε 

όλη την εικόνα. Αλλά αν κρατήσουμε τα ROIs για τις κατηγορίες που δεν θέλουμε άλλο να τις 

διαχωρίσουμε, δεν θα χρειαστεί να πάρουμε ξανά δείγματα για αυτές τις κατηγορίες. Κάτι είναι και 

αυτό. 

Ας γυρίσουμε ξανά στη στρατηγική μας. 

1. Τι θέλουμε; 

Να ταξινομήσουμε με επιβλεπόμενη ταξινόμηση, την περιοχή αρμοδιότητας του Φορέα Διαχείρισης 

Εθνικού Πάρκου Ροδόπης, στις εξής κατηγορίες: α) Νερό, β) Ανοίγματα, γ) Μερικώς δασοσκεπείς 

εκτάσεις, δ) Ερυθρελάτη, ε) Πεύκη, στ) Οξυά και ζ) Δρυοδάση - Λοιπά πλατύφυλλα 

2. Πως θα συλλέξουμε δείγματα εκπαίδευσης; 

Με οπτική ερμηνεία από την οθόνη και ψηφιοποίηση "καθαρών" περιοχών ανά κατηγορία 

3. Δημιουργία κατάλληλων ψευδο-έγχρωμων εικόνων  

Θα πρέπει να δημιουργήσουμε κατάλληλες ψευδο-έγχρωμες εικόνες (ακόμα και ανά ειδική κατηγορία) 

με στόχο να διακρίνουμε τα δείγματα μας. Να θυμίσω εδώ, ότι αν και το μάτι μας βλέπει χρώματα σε 

τρεις ζώνες φάσματος, ο Η/Υ μπορεί μαθηματικά να συνδυάσει τιμές από n-ζώνες και να δημιουργήσει 

φασματικές ομάδες που θα την μετασχηματίσει σε θεματικές ομάδες. 

4. Δημιουργία των κατάλληλων ROIs και έλεγχος της διαφοροποίησης τους 

5. Εφαρμογή των δειγμάτων εκπαίδευσης στον κατάλληλο αλγόριθμο και έλεγχο της απόδοσης του. 
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Πάμε ... 

Με βάση τα παραπάνω, το κρίσιμο είναι η συλλογή των κατάλληλων δειγμάτων. Για τα νερά, 

ανοίγματα και ΜΔ τα έχουμε, άρα εστιάζουμε στα δασικά είδη.  

Αν δούμε ξανά τις δύο ψευδοέγχρωμες εικόνες που έχουμε μέχρι τώρα δουλέψει (543 και 753) σε 

δασικές περιοχές με μίξη κωνοφόρων και πλατύφυλλων, τι βλέπετε;  

543               753 

 

 

 

 

 

 

1) Στο 543, στα κωνοφόρα, (κάποια πράσινα και κάποια σκούρα μωβ), που πιθανώς είναι πεύκα και 

ερυθρελάτη αντίστοιχα, αλλά όχι έντονη διαφοροποίηση, ενώ τα πράσινα (πλατύφυλλα) είναι όλα ίδια. 

2) Στο 753, στα πλατύφυλλα (ανοιχτά πράσινα) μια αυξημένη ένταση του πράσινου στα δεξιά και πιο 

αχνό στα κάτω αριστερά (που είναι στην ουσία οξυά και δρυοδάση αντίστοιχα), αλλά όχι έντονη 

διαφοροποίηση, ενώ τα κωνοφόρα είναι με την ίδια απόχρωση. 

Τι σημαίνει αυτό; 

Ότι την εποχή λήψης της εικόνας (θυμίζω Ιούνιος 2009) τα βασικά δασικά είδη έχουν χαρακτηριστικά 

στη δομή των φύλλων τους, που διαφοροποιούν την απορρόφηση και αντανάκλαση στις διάφορες 

φασματικές ζώνες, γι’ αυτό και υπάρχει οπτική διαφοροποίηση στα RGBs. Αυτό είναι σημαντικό για την 

εργασία μας, άρα θα προσπαθήσουμε να δημιουργήσουμε περισσότερες φασματικές ζώνες που να 

αναδεικνύουν τα χαρακτηριστικά αυτά.  

Η βασική τεχνική είναι ο μετασχηματισμός των φασματικών ζωνών σε μαθηματικές ζώνες (άξονες 

πληροφορίας), όπου ο 1ος άξονας παίρνει το μεγαλύτερο ποσοστό καθαρής πληροφορίας με βάση την 

κυριαρχία των κατηγοριών στην κάθε περιοχή μελέτης (π.χ. δρυοδάση), ο 2ος άξονας κάθετος στον 1ο, 

παίρνει τελείως διαφορετική πληροφορία, μια και είναι εντελώς μη συσχετιζόμενοι (π.χ. ανοίγματα). 

Στη συνέχεια ο 3ος, 4ος κλπ, συλλέγουν όλο και μικρότερη καθαρή πληροφορία. Στη δική μας 

περίπτωση, θα θέλουμε να δούμε αν τα διάφορα δασικά είδη (4 σε εμάς) έχουν μια σχετική κυριαρχία 

(μεγάλες τιμές) σε κάποιον από τους άξονες που θα δημιουργήσουμε. 
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Αν συμβαίνει αυτό, τότε θα μπορέσουμε να δημιουργήσουμε κατάλληλα έγχρωμα σύνθετα για να 

συλλέξουμε τα αναγκαία ROIs για την ταξινόμηση. 

Όλα τα εργαλεία μετασχηματισμού είναι στο βασικό μενού > Transform και θα χρησιμοποιήσουμε τα 

Principal Components και Independent Components.  Δεν θα ασχοληθούμε σε βάθος 

με τι κάνουν αυτοί οι μετασχηματισμοί (περισσότερο από ότι περιγράφηκε 

παραπάνω), αλλά ο αρχικός στόχος μας είναι να δούμε αν υπάρχουν άξονες σε 

αυτούς τους μετασχηματισμούς που μας βοηθάνε στην αναγνώριση των δασικών 

ειδών που θέλουμε.Γι αυτό σε κάθε περίπτωση επιλέγουμε  

  

 

 

Προσοχή, εκτελούμε τις μαθηματικές πράξεις στη δορυφορική 

εικόνα (L5 με έξι ζώνες). Αφήνετε τις προκαθορισμένες τιμές και 

φορτώνετε τους άξονες στη μνήμη.  

 

Αν τα έχετε κάνει όλα σωστά θα έχετε στο Band List τη διπλανή 

εικόνα, όπου με βάση τις έξι αρχικές ζώνες της Landsat 5 έχουν 

δημιουργηθεί αντίστοιχες ζώνες, για την PCA (φαίνονται ως PC 

Band1, PC Band 2), και για την ICA (IC Band1, IC Band2..). 

Δοκιμάστε λίγο με το Animation να δείτε τι πληροφορία σας δίνει 

ο κάθε άξονας για να δούμε τι θα μπορούσαμε να 

χρησιμοποιήσουμε. Να θυμίσω ξανά, ψάχνουμε να διακρίνουμε οπτικά με σαφήνεια, ερυθρελάτη, 

πεύκη, οξυά και δρυοδάση. 

Για να γίνει αυτό, από το μενού της εικόνας Tools > Animation και επιλέγουμε (όλους) τους άξονες που 

θέλουμε να δούμε. Πατήστε το pause για να πηγαίνετε μηχανικά άξονα - άξονα. 

Π.χ. η PC Band 4 μας ξεχωρίζει πολύ τα ανοίγματα στη Ροδόπη. 
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Μια επιπλέον καλή τεχνική είναι να εφαρμόσουμε στους άξονες της ICA ένα επιπλέον μετασχηματισμό 

MNF (Minimum Noise Fraction Transform). Μην ρωτάτε γιατί και πως, έχει βρεθεί να δουλεύει καλά 

στο διαχωρισμό των ειδών. 

 

Αν τα έχετε κάνει όλα MNF 1 δείχνει έντονα την ερυθρελάτη, η MNF 2 την οξυά (σε μικρότερες τιμές) , 

η ICA 3 τα ανοίγματα, η PCA 1 τα κωνοφόρα και η PCA 2 την οξυά. 

Ας κάνουμε  μερικά έγχρωμα σύνθετα με βάση αυτές τις πληροφορίες. 

Διαμορφώστε ένα RGB με PC1, MNF2 και MNF1 

 

 

 

 

Τι κοινά έχουν όλα αυτά;  

Τα κωνοφόρα έχουν υψηλές τιμές, άρα στο RGB θα έχουν σχεδόν λευκή 

απεικόνιση. Η Οξυά έχει πολύ μικρές τιμές στη MNF 2, άρα θα έχει και πολύ μικρές 

τιμές στο πράσινο, οπότε το κόκκινο και μπλέ θα μας δώσουν μια μωβ απόχρωση.  

 

 

Τα νερά είχαν υψηλές τιμές στο R και G = κίτρινο, ενώ 

ξεχωρίζουν και τα δρυοδάση (αφού έχουν 

υψηλότερες τιμές στο G από ότι η Οξυά, αλλά πολύ 

μικρότερες στο R και B. 

 

Για τις δρυς (επειδή τα πράσινα μπερδεύουν και με τα ανοίγματα, κάντε ένα 

RBG με IC1, IC2 και IC3, όπου οι δρύς ξεχωρίζουν με τα πορτακαλί χρώματα 

(σε σχέση με τα κόκκινα της Οξυάς και τα μπλέ των ανοιγμάτων). 
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Αφού διακρίναμε τις Οξυές από τα δρυοδάση, ας ασχοληθούμε λίγο και με τα κωνοφόρα. Θέλουμε να 

διακρίνουμε πεύκα από Ερυθρελάτη. Μια πρώτη διαφοροποίηση είχαμε και στο 543.  

Φαίνεται ότι τα πιο πράσινα είναι τα πεύκα και το πιο 

μπλε - μωβ είναι η Ερυθρελάτη. Ας το δεχτούμε (αν 

και δεν είναι απόλυτα έτσι) και ας πάμε σε 

προσεκτική συλλογή των δειγμάτων μας. 

Να πάρετε δείγματα Ερυθρελάτης κοντά στα σύνορα 

(όπου έχει μεγαλύτερη κατανομή). 

 

 

Ανακεφαλαιώνοντας, στο 543, θα συλλέξουμε δείγματα για τα πεύκα/ ερυθρελάτη, στο  RGB με PC1, 

MNF2 και MNF1, δείγματα για οξυές και στο  RGB με ΙC1, IC2, IC3 για δρυς. 

Όπως και στο Level 2, στο ROI tool, κρατάμε νερά, ανοίγματα, ΜΔ, αλλά 

σβήνουμε τα δάση και παίρνουμε προσεκτικά νέα δείγματα. ΠΡΟΣΟΧΗ 

λόγω της έντονης μείξης των δασών, να πάρουμε μόνο μικρά αλλά 

καθαρά δείγματα. 

...και καλή μας τύχη. Ας αφήσουμε μετά τα μαθηματικά να παίξουν 

μπάλα. 

 

 

Όταν τελειώσουμε με τα ROI μας και πριν προβούμε σε ταξινόμηση τι κάνουμε για να δούμε αν είναι 

σωστά τα δείγματα; 

Αναμενόμενο.  

Τα πεύκα και οι ερυθρελάτες δεν μπορούν να διαχωριστούν επαρκώς και  

σε κάποιο βαθμό η οξυά από τις δρυς. Τι κάνουμε λοιπόν;  

 

Το πρόβλημα είναι είτε στα ROIs είτε στις ζώνες που κάνουμε ταξινόμηση.  
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Ας κάνουμε την 1η ταξινόμηση με τις έξι ζώνες της δορυφορικής εικόνας και ας προσπαθήσουμε να 

κάνουμε μια νέα εικόνα με συνένωση της αρχικής εικόνας και των τριών πρώτων αξόνων από τις PCA, 

ICA και MNF και να δοκιμάσουμε ξανά την ταξινόμηση.  

Πως??? Με Layer Stacking προφανώς!!! 

Αν τα έχετε σε memory, σημειώστε πριν το stacking τον αριθμό memory κάθε ανάλυσης.  

Σώστε το αρχείο γιατί θα κρεμάσει η memory. 

Δείτε τι διαφορά στην ταξινόμηση με τις 6 και τις 15 ζώνες. Αν δεν επηρεάζεται πολύ η ταξινόμηση, τα 

ROI θα χρειαστούν διόρθωση. 

 

Σας φάνηκε δύσκολη όλη η επιλογή των δειγμάτων;  

Το ευκολότερο είναι μέσω συλλογής δειγμάτων από εικόνες υψηλής ανάλυσης 

Σε μια πραγματική ταξινόμηση της Ροδόπης  είχαν αναγνωριστεί οι εξής κατηγορίες: 
1. Πλατύφυλλλα (Με κυριαρχία πλατυφύλλων δασικών ειδών, με μικρή συμμετοχή της δρυς) 
2. Οξυά 
3. Αραιά πλατύφυλλα (Μερικώς δασοσκεπείς εκτάσεις από πλατύφυλλα ή/και δρυ με μεγάλη ποσοστό ανοιχτών 
εκτάσεων) 
4. Ανοίγματα (Ανοιχτές εκτάσεις με μεμονωμένη παρουσία δέντρων, ξηρικές καλλιέργειες, οικισμοί) 
5. Ερυθρελάτη 
6. Πευκοδάση (Δασική και Μαύρη πεύκη) 
7. Δρυοδάση 
8. Υδάτινες επιφάνειες 
 
και τα δείγματα εκπαίδευσης αναγνωρίστηκαν με τη βοήθεια του Google Earth, όπου διαμορφώθηκαν αντίστοιχα πολύγωνα, 
ανά κατηγορία κάλυψης και στη συνέχεια εξαχθήκαν στο πρόγραμμα ENVI, μέσω του προγράμματος ArcGIS, σε μορφή 
δειγμάτων ταξινόμησης (Region Of Interest - ROI). Παράλληλα, έγινε και συλλογή δειγμάτων κατευθείαν από τη δορυφορική 
εικόνα, μέσα από το ENVI, για να υπάρχει καλή αντιπροσώπευση όλων των κατηγοριών. 
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ΑΣΚΗΣΗ 3 

Με βάση το νομό που έχετε χρεωθεί  

1. Κάντε επιβλεπόμενη ταξινόμηση σε δύο παρακάτω επίπεδα (δύο ταξινομήσεις) με τις μεθόδους 

Maxlike, Spectral Angle Mapper και Support Vector Machine 

 Επίπεδο 1: Δάσος, Μερικώς δασοσκεπής έκταση, Ανοίγματα, Υδάτινες επιφάνειες 

 Επίπεδο 2: Κωνοφόρα, Πλατύφυλλα, Μερικώς δασοσκεπής έκταση, Ανοίγματα, Υδάτινες 
επιφάνειες 
 

2.  Υπολογίστε το ποσοστό κάλυψης ανά κατηγορία τόσο για το επίπεδο 1 όσο και για το επίπεδο 2. 

3. Παρουσιάστε σε ένα πίνακα τα αποτελέσματα ανά κατηγορία/επίπεδο και μέθοδο και συζητήστε τις 

διαφορές που βρήκατε. 

4. Ποιά από τις μεθόδους ήταν η καλύτερη στο νομό σας και με ποιον τρόπο το βρήκατε αυτό; 

 

Υποχρεωτικά σημεία της άσκησης: 

 Η σωστή δομή της εργασίας (εξώφυλλο, εισαγωγή, στόχοι ερωτήματα, μεθοδολογία, 

αποτελέσματα, συζήτηση) 

 Η σωστή παρουσίαση των εικόνων, πινάκων με λεζάντα για κάθε εικόνα / πίνακα που να 

περιγράφει τι δείχνει 

 Η άσκηση να έχει σαφές κεφάλαιο για τη μεθοδολογία που ακολουθήσατε 

 Ο υπολογισμός και η παρουσίαση του πίνακα διαφοροποίησης των δειγμάτων σας (δεν θα 

είναι επιτρεπτές τιμές κάτω από 1.8) 


